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Chapter 400

One-Sample T-Tests
Introduction
The one-sample t-test is used to test whether the mean of a population is greater than, less than, or not equal to a
specific value. Because the t distribution is used to calculate critical values for the test, this test is often called the
one-sample t-test. The t-test assumes that the population standard deviation is unknown and will be estimated by the
data.
When the data are differences between paired values, this test is known as the paired t-test.

Other PASS Procedures for Testing One Mean or Median
Procedures in PASS are primarily built upon the testing methods, test statistic, and test assumptions that will be
used when the analysis of the data is performed. You should check to identify that the test procedure described
below in the Test Procedure section matches your intended procedure. If your assumptions or testing method are
different, you may wish to use one of the other one-sample procedures available in PASS–the One-Sample ZTests and the nonparametric Wilcoxon Signed-Rank Test procedures. The methods, statistics, and assumptions for
those procedures are described in the associated chapters.
If you wish to show that the mean of a population is larger (or smaller) than a reference value by a specified
amount, you should use one of the clinical superiority procedures for comparing means. Non-inferiority,
equivalence, and confidence interval procedures are also available.

The Statistical Hypotheses
In the usual t-test setting, the null (𝐻𝐻0 ) and alternative (𝐻𝐻1 ) hypotheses for two-sided tests are defined as
𝐻𝐻0 : 𝜇𝜇 = 𝜇𝜇0

versus

𝐻𝐻0 : 𝜇𝜇 ≤ 𝜇𝜇0

versus

𝐻𝐻0 : 𝜇𝜇 ≥ 𝜇𝜇0

versus

𝐻𝐻1 : 𝜇𝜇 ≠ 𝜇𝜇0 .

Rejecting 𝐻𝐻0 implies that the mean is not equal to the value 𝜇𝜇0 . The hypotheses for one-sided upper-tail tests are
𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0 .

Rejecting 𝐻𝐻0 implies that the mean is larger than the value 𝜇𝜇0 . This test is called an upper-tail test because 𝐻𝐻0 is
rejected in samples in which the sample mean is larger than 𝜇𝜇0 .
The lower-tail test is

𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0 .
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It will be convenient to adopt the following specialize notation for the discussion of these tests.
Parameter
𝜇𝜇

PASS Input/Output Interpretation
𝜇𝜇
Population mean. If the data are paired differences, this is the mean of
those differences. This parameter will be estimated by the study.

𝜇𝜇0

𝜇𝜇0

Reference value. Usually, this is the mean of a reference population. If
the data are paired differences, this is the hypothesized value of the mean
difference.

𝛿𝛿

𝛿𝛿

Population difference. This is the value of 𝜇𝜇 − 𝜇𝜇0 , the difference
between the population mean and the reference value. This parameter
will be estimated by the study.

𝛿𝛿1

𝛿𝛿1

Actual difference at which power is calculated. This is the value of
𝜇𝜇1 − 𝜇𝜇0 , the assumed difference between the mean and the reference
value for power calculations.

𝜇𝜇1

𝜇𝜇1

Actual population mean at which power is calculated. This is the
assumed population mean used in all calculations.

Test Procedure
1. Find the critical value. Assume that the true mean is 𝜇𝜇0 . Choose a value 𝑇𝑇𝛼𝛼 so that the probability of
rejecting 𝐻𝐻0 when 𝐻𝐻0 is true is equal to a specified value called α. Using the t distribution, select 𝑇𝑇𝛼𝛼 so that
Pr(𝑡𝑡 > 𝑇𝑇𝛼𝛼 ) = 𝛼𝛼. This value is found using a t probability table or a computer program (like PASS).
2. Select a sample of n items from the population and compute the t statistic. Call this value T. If 𝑇𝑇 > 𝑇𝑇𝛼𝛼
reject the null hypothesis that the mean equals 𝜇𝜇0 in favor of an alternative hypothesis that the mean is
greater than 𝜇𝜇0 .

Following is a specific example. Suppose we want to test the hypothesis that a variable, X, has a mean of 100 versus
the alternative hypothesis that the mean is greater than 100. Suppose that previous studies have shown that the
standard deviation, 𝜎𝜎, is 40. A random sample of 100
individuals is used.

We first compute the critical value, 𝑇𝑇𝛼𝛼 . The value of 𝑇𝑇𝛼𝛼 that
yields α = 0.05 is 106.6. If the mean computed from a
sample is greater than 106.6, reject the hypothesis that the
mean is 100. Otherwise, do not reject the hypothesis. We
call the region greater than 106.6 the Rejection Region and
values less than or equal to 106.6 the Acceptance Region of
the significance test.

Figure 1 - Finding Alpha
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Now suppose that you want to compute the power of this
testing procedure. In order to compute the power, we must
specify an alternative value for the mean. We decide to
compute the power if the true mean were 110. Figure 2
shows how to compute the power in this case.

Figure 2 - Finding Power

The power is the probability of rejecting 𝐻𝐻0 when the true
mean is 110. Since we reject 𝐻𝐻0 when the calculated mean
is greater than 106.6, the probability of a Type-II error
(called β) is given by the dark, shaded area of the second
graph. This value is 0.196. The power is equal to 1 – β or
0.804.
Note that there are six parameters that may be varied in
this situation: two means, standard deviation, alpha,
power, and the sample size.

Assumptions for One-Sample Tests
This section describes the assumptions that are made when you use one of the one-sample tests. The key
assumption relates to normality or non-normality of the data. One of the reasons for the popularity of the t-test is
its robustness in the face of assumption violation. However, if an assumption is not met even approximately, the
significance levels and the power of the t-test are invalidated. Unfortunately, in practice it often happens that
several assumptions are not met. This makes matters even worse! Hence, take the steps to check the assumptions
before you make important decisions based on these tests.

One-Sample Z-Test Assumptions
The assumptions of the one-sample z-test are:
1. The data are continuous (not discrete).
2. The data follow the normal probability distribution.
3. The sample is a simple random sample from its population. Each individual in the population has an equal
probability of being selected in the sample.
4. The population standard deviation is known.

One-Sample T-Test Assumptions
The assumptions of the one-sample t-test are:
1. The data are continuous (not discrete).
2. The data follow the normal probability distribution.
3. The sample is a simple random sample from its population. Each individual in the population has an equal
probability of being selected in the sample.
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Paired T-Test Assumptions
The assumptions of the paired t-test are:
1. The data are continuous (not discrete).
2. The data, i.e., the differences for the matched-pairs, follow a normal probability distribution.
3. The sample of pairs is a simple random sample from its population. Each individual in the population has
an equal probability of being selected in the sample.

Wilcoxon Signed-Rank Test Assumptions
The assumptions of the Wilcoxon signed-rank test are as follows:
1. The data are continuous (not discrete).
2. The distribution is symmetric.
3. The data are mutually independent.
4. The data have the same median.
5. The measurement scale is at least interval.

Limitations
There are few limitations when using these tests. Sample sizes may range from a few to several hundred. If your
data are discrete with at least five unique values, you can often ignore the continuous variable assumption.
Perhaps the greatest restriction is that your data come from a random sample of the population. If you do not have
a random sample, your significance levels will probably be incorrect.

One-Sample T-Test Statistic
The one-sample t-test assumes that the data are a simple random sample from a population of normallydistributed values that all have the same mean and variance. This assumption implies that the data are continuous
and their distribution is symmetric. The calculation of the t-test proceeds as follows
𝑡𝑡𝑛𝑛−1 =

where
𝑋𝑋� =

∑𝑛𝑛𝑖𝑖=1 𝑋𝑋𝑖𝑖
,
𝑛𝑛

𝑋𝑋� − 𝜇𝜇0
𝑠𝑠⁄√𝑛𝑛

∑𝑛𝑛 (𝑋𝑋𝑖𝑖 − 𝑋𝑋�)2
,
𝑠𝑠 = � 𝑖𝑖=1
𝑛𝑛 − 1

and 𝜇𝜇0 is the value of the mean hypothesized by the null hypothesis.

The significance of the test statistic is determined by computing the p-value. If this p-value is less than a specified
level (usually 0.05), the hypothesis is rejected. Otherwise, no conclusion can be reached.
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Power Calculation for the One-Sample T-Test
When the standard deviation is unknown, the power is calculated as follows for a directional alternative (onetailed test) in which 𝜇𝜇1 > 𝜇𝜇0 .

1. Find 𝑡𝑡𝛼𝛼 such that 1 − 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) = 𝛼𝛼, where 𝑇𝑇𝑑𝑑𝑑𝑑 (𝑡𝑡𝛼𝛼 ) is the area under a central-t curve to the left of x and
df = n – 1.

2. Calculate: 𝑋𝑋1 = 𝜇𝜇0 + 𝑡𝑡𝛼𝛼

𝜎𝜎
.
√𝑛𝑛

3. Calculate the noncentrality parameter: 𝜆𝜆 =

4. Calculate: 𝑡𝑡1 =

𝑋𝑋1 −𝜇𝜇1
𝜎𝜎
√𝑛𝑛

+ 𝜆𝜆.

𝜇𝜇1 −𝜇𝜇0
𝜎𝜎
√𝑛𝑛

=

𝛿𝛿1

𝜎𝜎
√𝑛𝑛

.

′
′
(𝑡𝑡1 ), where 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
(𝑥𝑥) is the area to the left of x under a noncentral-t curve with degrees
5. Power = 1 − 𝑇𝑇𝑑𝑑𝑑𝑑,𝜆𝜆
of freedom df and noncentrality parameter 𝜆𝜆.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power of an experiment that has already been run.

Test
Alternative Hypothesis
Specify the alternative hypothesis of the test. Since the null hypothesis is the opposite of the alternative,
specifying the alternative is all that is needed. Usually, the two-tailed (≠) option is selected.
The options containing only < or > are one-tailed tests. When you choose one of these options, you must be sure
that the input parameters match this selection.
Possible selections are:
•

Two-Sided (H1: μ ≠ μ0)
This is the most common selection. It yields the two-tailed t-test. Use this option when you are testing
whether the means are different, but you do not want to specify beforehand which mean is larger. Many
scientific journals require two-tailed tests.
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•

One-Sided (H1: μ < μ0)
This option yields a one-tailed t-test. Use it when you are only interested in the case in which μ is less than
μ0.

•

One-Sided (H1: μ > μ0)
This option yields a one-tailed t-test. Use it when you are only interested in the case in which μ is greater than
μ0.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
𝑛𝑛

The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250
or 50 to 250 by 50.
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Effect Size – Means
μ0 (Null or Baseline Mean)
Enter a value for the population mean under the null hypothesis. This is the reference or baseline mean. If you are
analyzing a paired t-test, this value should be zero.
Only the difference between μ1 and μ0 is used in the calculations.
μ1 (Actual Mean)
Enter a value (or range of values) for the actual population mean at which power and sample size are calculated.
Only the difference between μ1 and μ0 is used in the calculations.

Effect Size – Standard Deviation
σ (Standard Deviation)
This option specifies one or more values of the standard deviation. This must be a positive value. Be sure to use
the standard deviation of X and not the standard deviation of the mean (the standard error). If you are doing a
paired test, this is the standard deviation of the differences.
When this value is not known, you must supply an estimate of it. PASS includes a special tool for estimating the
standard deviation. This tool may be loaded by pressing the SD button. Refer to the Standard Deviation Estimator
chapter for further details.
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Example 1 – Power after a Study
This example will cover the situation in which you are calculating the power of a t-test on data that have already
been collected and analyzed. For example, you might be playing the role of a reviewer, looking at the power of a
t-test from a study you are reviewing. In this case, you would not vary the means, standard deviation, or sample
size since they are given by the experiment. Instead, you investigate the power of the significance tests. You
might look at the impact of different alpha values on the power.
Suppose an experiment involving 100 individuals yields the following summary statistics:
Hypothesized mean (μ0)
Sample mean (μ1)
Sample standard deviation
Sample size

100.0
110.0
40.0
100

Given the above data, analyze the power of a t-test which tests the hypothesis that the population mean is 100
versus the alternative hypothesis that the population mean is 110. Consider the power at significance levels 0.01,
0.05, 0.10 and sample sizes 20 to 120 by 20.
Note that we have set μ1 equal to the sample mean. In this case, we are studying the power of the t-test for a mean
difference the size of that found in the experimental data.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Alpha ....................................................... 0.01 0.05 0.10
N (Sample Size)...................................... 20 to 120 by 20
μ0 (Null or Baseline Mean) ..................... 100
μ1 (Actual mean) .................................... 110
σ (Standard Deviation) ........................... 40
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Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
N
0.06051
20
0.14435
40
0.24401
60
0.34953
80
0.45316 100
0.54958 120
(report continues)

μ0
100.0
100.0
100.0
100.0
100.0
100.0

μ1
110.0
110.0
110.0
110.0
110.0
110.0

Diff
μ1 - μ0
10.0
10.0
10.0
10.0
10.0
10.0

σ
40.0
40.0
40.0
40.0
40.0
40.0

Effect
Size
0.250
0.250
0.250
0.250
0.250
0.250

Alpha
0.010
0.010
0.010
0.010
0.010
0.010

Beta
0.93949
0.85565
0.75599
0.65047
0.54684
0.45042

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the size of the sample drawn from the population. To conserve resources, it should be small.
μ0 is the value of the population mean under the null hypothesis.
μ1 is the actual value of the population mean at which power and sample size are calculated.
μ1 - μ0 is the difference between the actual and null means.
σ is the standard deviation of the population. It measures the variability in the population.
Effect Size = |μ1 - μ0|/σ is the relative magnitude of the effect.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 20 achieves 6% power to detect a difference of 10.0 between the actual mean of
110.0 and the null hypothesized mean of 100.0 with an estimated standard deviation of 40.0 and
with a significance level (alpha) of 0.010 using a two-sided one-sample t-test.

This report shows the values of each of the parameters, one scenario per row. The values of power and beta were
calculated from the other parameters.
The definitions of each column are given in the Report Definitions section.

Plots Section

These plots show the relationship between sample size and power for various values of alpha.
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Example 2 – Finding the Sample Size
This example will consider the situation in which you are planning a study that will use the one-sample t-test and
want to determine an appropriate sample size. This example is more subjective than the first because you now
have to obtain estimates of all the parameters. In the first example, these estimates were provided by the data.
In studying deaths from SIDS (Sudden Infant Death Syndrome), one hypothesis put forward is that infants dying
of SIDS weigh less than normal at birth. Suppose the average birth weight of infants is 3300 grams with a
standard deviation of 663 grams. Use an alpha of 0.05 and power of both 0.80 and 0.90. How large a sample of
SIDS infants will be needed to detect a drop in average weight of 25%? Of 10%? Of 5%? Note that applying these
percentages to the average weight of 3300 yields 2475, 2970, and 3135.
Although a one-sided hypothesis is being considered, sample size estimates will assume a two-sided alternative to
keep the research design in line with other studies.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80 0.90
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 3300
μ1 (Actual mean) .................................... 2475 2970 3135
σ (Standard Deviation) ........................... 663

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.85339
0.90307
0.80426
0.90409
0.80105
0.90070

N
8
9
34
45
129
172

μ0
3300.0
3300.0
3300.0
3300.0
3300.0
3300.0

μ1
2475.0
2475.0
2970.0
2970.0
3135.0
3135.0

Diff
μ1 - μ0
-825.0
-825.0
-330.0
-330.0
-165.0
-165.0

σ
663.0
663.0
663.0
663.0
663.0
663.0

Effect
Size
1.244
1.244
0.498
0.498
0.249
0.249

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.14661
0.09693
0.19574
0.09591
0.19895
0.09930

This report shows the values of each of the parameters, one scenario per row. Since there were three values of μ1
and two values of power, there are a total of six rows in the report.
We were solving for the sample size, N. Notice that the increase in sample size seems to be most directly related
to the difference between the two means. The difference in beta values does not seem to be as influential,
especially at the smaller sample sizes.
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Note that even though we set the power values at 0.8 and 0.9, these are not the power values that were achieved.
This happens because N can only take on integer values. The program selects the first value of N that gives at
least the values of alpha and power that were desired.

Example 3 – Finding the Minimum Detectable Difference
This example will consider the situation in which you want to determine how small of a difference between the
two means can be detected by the t-test with specified values of the other parameters.
Continuing with the previous example, suppose about 50 SIDS deaths occur in a particular area per year. Using
50 as the sample size, 0.05 as alpha, and 0.80 as power, how large of a difference between the means is
detectable?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ μ1 (Search < μ0)
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
N (Sample Size)...................................... 50
μ0 (Null or Baseline Mean) ..................... 3300
σ (Standard Deviation) ........................... 663

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.80000

N
50

μ0
3300.0

μ1
3032.0

Diff
μ1 - μ0
-268.0

σ
663.0

Effect
Size
0.404

Alpha
0.050

Beta
0.20000

With a sample of 50, a difference of 3032 - 3300 = -268 would be detectable. This difference represents about an
8% decrease in weight.
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Example 4 – Paired T-Test
Usually, a researcher designs a study to compare two or more groups of subjects, so the one sample case
described in this chapter occurs infrequently. However, there is a popular research design that does lead to the
single mean test: paired observations.
For example, suppose researchers want to study the impact of an exercise program on the individual’s weight. To
do so they randomly select N individuals, weigh them, put them through the exercise program, and weigh them
again. The variable of interest is not their actual weight, but how much their weight changed.
In this design, the data are analyzed using a one-sample t-test on the differences between the paired observations.
The null hypothesis is that the average difference is zero. The alternative hypothesis is that the average difference
is some nonzero value.
To study the impact of an exercise program on weight loss, the researchers decide to conduct a study that will be
analyzed using the paired t-test. A sample of individuals will be weighed before and after a specified exercise
program that will last three months. The difference in their weights will be analyzed.
Past experiments of this type have had standard deviations in the range of 10 to 15 pounds. The researcher wants
to detect a difference of 5 pounds or more. Alpha values of 0.01 and 0.05 will be tried. Beta is set to 0.20 so that
the power is 80%. How large of a sample must the researchers take?

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.01 0.05
μ0 (Null or Baseline Mean) ..................... 0
μ1 (Actual mean) .................................... -5
σ (Standard Deviation) ........................... 10 12.5 15
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Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.80939
0.80778
0.80434
0.80779
0.80252
0.80230

N
51
34
77
52
109
73

μ0
0.0
0.0
0.0
0.0
0.0
0.0

μ1
-5.0
-5.0
-5.0
-5.0
-5.0
-5.0

Diff
μ1 - μ0
-5.0
-5.0
-5.0
-5.0
-5.0
-5.0

σ
10.0
10.0
12.5
12.5
15.0
15.0

Effect
Size
0.500
0.500
0.400
0.400
0.333
0.333

Alpha
0.010
0.050
0.010
0.050
0.010
0.050

Beta
0.19061
0.19222
0.19566
0.19221
0.19748
0.19770

The report shows the values of each of the parameters, one scenario per row. We were solving for the sample size,
N.
Note that depending on our choice of assumptions, the sample size ranges from 34 to 109. Hence, the researchers
have to make a careful determination of which standard deviation and significance level should be used.
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Example 5 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) presents an example on pages 45 and 46 of a two-sided one-sample ttest sample size calculation in which μ0 = 1.5, μ1 = 2.0, σ = 1.0, alpha = 0.05, and power = 0.80. They obtain a
sample size of 34.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 1.5
μ1 (Actual Mean) .................................... 2
σ (Standard Deviation) ........................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.80778

N
34

μ0
1.5

μ1
2.0

Diff
μ1 - μ0
0.5

σ
1.0

Effect
Size
0.500

Alpha
0.050

Beta
0.19222

The sample size of 34 matches Chow, Shao, Wang, and Lokhnygina (2018) exactly.
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Example 6 – Validation using Zar (1984)
Zar (1984) pages 111-112 presents an example in which μ0 = 0.0, μ1 = 1.0, σ = 1.25, alpha = 0.05, and N = 12.
Zar obtains an approximate power of 0.72.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 6 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Alpha ....................................................... 0.05
N (Sample Size)...................................... 12
μ0 (Null or Baseline Mean) ..................... 0
μ1 (Actual mean) .................................... 1
σ (Standard Deviation) ........................... 1.25

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.71366

N
12

μ0
0.0

μ1
1.0

Diff
μ1 - μ0
1.0

σ
1.3

Effect
Size
0.800

Alpha
0.050

Beta
0.28634

The difference between the power computed by PASS of 0.71366 and the 0.72 computed by Zar is due to Zar’s
use of an approximation to the noncentral t distribution.
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Example 7 – Validation using Machin (1997)
Machin, Campbell, Fayers, and Pinol (1997) page 37 presents an example in which μ0 = 0.0, μ1 = 0.2, σ = 1.0,
alpha = 0.05, and beta = 0.20. They obtain a sample size of 199.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the One-Sample T-Tests procedure window by expanding Means, then One Mean, then clicking
on T-Test (Inequality), and then clicking on One-Sample T-Tests. You may then make the appropriate entries
as listed below, or open Example 7 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (H1: μ ≠ μ0)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
μ0 (Null or Baseline Mean) ..................... 0
μ1 (Actual mean) .................................... 0.2
σ (Standard Deviation) ........................... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Hypotheses: H0: μ = μ0 vs. H1: μ ≠ μ0
Power
0.80169

N
199

μ0
0.0

μ1
0.2

Diff
μ1 - μ0
0.2

σ
1.0

Effect
Size
0.200

Alpha
0.050

Beta
0.19831

The sample size of 199 matches Machin’s result.
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